Kepler - Issues

# Tracker Status Priority Subject Assignee Updated

5101 Bug Resolved Normal Composite Actor windows show wrong title after workflow Rename Aaron Aaron 01/04/2011 11:53 PM
4967 Bug Resolved Normal Disallow dragging romls, workflowRuns, etc onto canvas Aaron Aaron 07/14/2011 12:22 PM
4885 Bug Resolved Normal Right-clicking on KARs in the component pane produces exception Aaron Aaron 03/23/2010 12:46 PM
4791 Bug Resolved Normal Actor names no longer have spaces Aaron Aaron 02/12/2010 03:16 PM
4449 Bug Resolved Normal exception when dragging workflow Aaron Aaron 12/02/2009 01:03 PM
4370 Bug Resolved Normal Changes to Components and Data Preferences disappear on relaunch Aaron Aaron 09/18/2009 03:35 PM
4362 Bug Resolved Normal component search performance Aaron Aaron 01/24/2010 04:23 PM
4346 Bug Resolved Normal Searching for Saved Archive (KAR) workflow in default workflow folder gives error Aaron Aaron 10/02/2009 05:17 PM
4321 Bug Resolved Normal Semantic types on workflows saved into library not searchable Aaron Aaron 10/15/2009 12:14 PM
3803 Bug New Low Cannot open a workflow through the command prompt, open with, or send to menus ben leinfelder 04/21/2009 11:13 AM
5203 Bug Resolved Normal Kepler wont start Chad Berkley 08/10/2011 10:06 AM
5187 Bug New Normal GUI should make apparent unsaved changes Chad Berkley 10/01/2010 12:54 PM
5081 Bug New Normal A system for adding and removing GUI menus. Chad Berkley 07/07/2010 10:26 AM
5029 Bug Resolved Normal Parameter changes can be committed without clicking the commit button Chad Berkley 05/25/2010 11:50 AM
5012 Bug New Normal highlighted OK button in 'Annimate at runtime ... menu item does not work. Chad Berkley 05/15/2010 11:18 AM
4936 Bug Resolved Normal Preferences for searching remote repositories are not maintained across runs Chad Berkley 04/27/2010 03:03 PM
4934 Bug New Normal Certain non-user triggered actor icon changes are not reflected immediately in the zoom widget Chad Berkley 04/06/2010 01:58 PM
4711 Bug Resolved Normal Problem with L.H. actor tree: ActorName kar Chad Berkley 06/13/2012 07:15 PM
4371 Bug New Normal pipe highlighting under "Animate at Runtime" Chad Berkley 02/10/2012 12:19 AM
4343 Bug Resolved Immediate remove the full screen button Chad Berkley 09/18/2009 11:34 AM
4162 Bug New Normal using the alt key makes menus appear in strange places on OSX Chad Berkley 08/26/2009 02:55 PM
3944 Bug New Normal External script editors Chad Berkley 04/06/2009 10:08 AM
3932 Bug Resolved Normal Configure Actor actor context menu item missing Chad Berkley 04/30/2009 04:54 PM
3900 Bug Resolved Normal leaving fullscreen mode gives an NPE and closes window Chad Berkley 04/22/2009 03:48 PM
3802 Bug New Normal actor icons prevent channel connectors to align straight Chad Berkley 04/03/2009 02:18 PM
3724 Bug New Normal composite's ports cannot be renamed from within composite--add context menu? Chad Berkley 08/07/2009 02:34 PM
3723 Bug Resolved Normal all actors appear in the same upper-left position when dragged onto canvas Chad Berkley 01/06/2009 02:57 PM
3408 Bug New Low create icon for DDF Boolean Select Chad Berkley 04/03/2009 02:18 PM
3407 Bug New Normal reset debugging windows, add timestamps Chad Berkley 04/03/2009 02:18 PM
3333 Bug New Normal "configure actor" dialog box changes after "documentation->display" Chad Berkley 04/03/2009 02:44 PM
2325 Bug Resolved Normal Actor Library Folders Should Not Be Draggable Chad Berkley 01/25/2006 02:26 PM
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2192 Bug Resolved Normal Improve QuickSearch results from Digir Chad Berkley 09/08/2005 02:29 PM
1556 Bug Resolved Normal problems with one-button mouse on Macintosh Chad Berkley 05/27/2004 03:50 PM
1546 Bug Resolved Immediate dynamic data and actor views using ontologies Chad Berkley 10/12/2004 11:06 AM
1543 Bug Resolved Low create workflow scripting language Chad Berkley 10/12/2004 10:59 AM
1341 Bug Resolved Normal need a viewing toolbox Chad Berkley 10/12/2004 10:58 AM
1331 Bug Resolved Immediate interface enhancements Chad Berkley 02/09/2004 08:36 AM
1330 Bug Resolved Immediate interface enhancements Chad Berkley 11/02/2005 01:02 PM
6834 Bug Resolved Normal kepler data can icon displayed incorrectly Christopher Brooks 09/10/2015 01:19 PM
6831 Bug Closed Normal saving/loading window properties for multiple graphs/models in BasicGraphFrame Christopher Brooks 08/17/2015 01:14 PM
5703 Bug Resolved Normal GUI bug - Deleting an Actor with connected port causes a diamond relation to be created. Christopher Brooks 09/07/2012 10:27 AM
5607 Bug Resolved Normal constant actor icon won't automatically re-size since 2.3. Christopher Brooks 08/06/2012 11:47 AM
5587 Bug Resolved Normal long parameter values get replaced with scrollbar Christopher Brooks 08/29/2012 09:44 PM
5571 Bug Resolved Normal user request: show execution time in runtime window Christopher Brooks 06/15/2012 02:23 PM
4826 Bug Resolved Normal intermittent exceptions displaying matrix tokens Christopher Brooks 03/01/2010 09:59 PM
4053 Bug Resolved Normal deleting open composite actor may delete model Christopher Brooks 05/19/2009 07:48 AM
3801 Bug Resolved Normal open dialog, common places pane has white box instead of text Christopher Brooks 06/17/2012 01:57 PM
3471 Bug Resolved Normal custom input boxes in actor configuration dialog Christopher Brooks 09/19/2008 06:17 PM
3003 Bug Resolved Normal Copy/Paste of selection: copy should be selected Christopher Brooks 06/28/2012 09:38 PM
3002 Bug Resolved Normal Copy/Paste of a relation (diamond) Christopher Brooks 03/24/2008 07:39 PM
2870 Bug Resolved Normal Copy/Paste of composite actors Christopher Brooks 03/22/2008 11:10 AM
2571 Bug Resolved Normal position of new elements on screen Christopher Brooks 06/26/2012 01:04 PM
2531 Bug Resolved Immediate The link from Kepler intro page to the Ptolemy quick links page is broken Christopher Brooks 04/15/2008 06:59 PM
2369 Bug Resolved Normal Scrollbars Disappear After Using Fullscreen Mode--Now crashes Christopher Brooks 06/12/2012 08:23 AM
2363 Bug Resolved Immediate Move Actions out of BasicGraphController Christopher Brooks 04/30/2009 09:58 AM
2246 Bug In Progress Normal TOOLBAR: status on opening workflows and blank frames Christopher Brooks 04/03/2009 02:18 PM
2110 Bug Resolved Normal Rename "Look Inside" to "Open Actor" Christopher Brooks 12/19/2005 12:06 PM
2032 Bug Resolved Immediate application should open to main window not web page Christopher Brooks 02/09/2006 09:44 AM
2990 Bug In Progress Normal filelopen dialog should open in workflows directory Dan Higgins 04/03/2009 02:05 PM
2672 Bug In Progress Normal actor search term should be trimmed + searching with multiple terms Dan Higgins 04/03/2009 02:18 PM
1557 Bug Resolved Immediate problems with paths with 'spaces’ Dan Higgins 03/01/2005 10:52 AM
6833 Feature Resolved Normal syntax highlighting for language actors Daniel Crawl 09/11/2015 11:11 AM
6615 Bug Resolved Normal apple-extensions does not compile with java 8 Daniel Crawl 08/12/2015 03:32 PM
6165 Bug Resolved Low The names of instances of the Stop actor do not display in Mac OSX. Daniel Crawl 12/23/2014 03:24 PM
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5789 Bug Resolved Normal component tree disappears after clicking Clear after downloading KAR Daniel Crawl 01/23/2013 01:50 PM
5760 Bug In Progress Normal saving xml to existing file asks twice on mac Daniel Crawl 12/19/2012 11:18 AM
5759 Bug Resolved Normal MatrixViewer window does not reappear Daniel Crawl 01/15/2013 09:34 AM
5727 Bug Resolved Normal saving workflow changes canvas center Daniel Crawl 01/16/2013 07:26 PM
5694 Bug Resolved Immediate Dragging from a port results in a NPE Daniel Crawl 09/07/2012 11:16 AM
5680 Bug Resolved Normal after inline save, demo workflow disappears from tree Daniel Crawl 09/17/2012 06:03 PM
5665 Bug Resolved Normal modulemanager et al.: swing-worker-1.2.jar should be removed Daniel Crawl 12/23/2014 03:19 PM
5659 Bug Closed Normal Kepler CaseGraphFrame and CaseGraphTableau have duplicated Ptolemy code. Daniel Crawl 08/17/2015 08:10 AM
5637 Bug Resolved Normal composite window size & position not always saved Daniel Crawl 09/12/2012 09:40 PM
5634 Bug Resolved Normal Kepler should have Configure Layout menu choices Daniel Crawl 06/26/2012 11:56 AM
5633 Bug Resolved Low Actor/Attribute Search/Find Facility needs menu choices Daniel Crawl 09/07/2012 09:26 AM
5588 Bug Resolved Normal Enter and Tab behavior has changed in parameter configuration dialog Daniel Crawl 08/24/2012 01:02 PM
5496 Bug Resolved Normal non-English (United State) OS locale causes File menu and button text to not show Daniel Crawl 09/27/2011 04:42 PM
5343 Feature New Normal Add optional Console view Daniel Crawl 08/16/2015 06:02 PM
5283 Bug Resolved Normal Ul for saving workflows as xml is confusing Daniel Crawl 06/28/2012 04:25 PM
4920 Bug New Normal dynamically change toolbar buttons Daniel Crawl 03/28/2011 05:11 PM
4749 Bug New Normal run google earth within kepler gui Daniel Crawl 03/28/2011 05:11 PM
4323 Bug In Progress Low Add the "send to back" menu to kepler Daniel Crawl 08/28/2009 10:54 AM
2335 Bug Resolved Normal MENUS: Top-Level Menu - dynamic addition of menu items Daniel Crawl 06/26/2012 12:08 PM
5450 Bug Resolved Normal Menu: Help -> Kepler Documentation causes lllegalArgumentException David Welker 11/03/2011 07:21 PM
5438 Bug Resolved Normal missed menubar and misformed buttons without text David Welker 08/04/2011 09:57 AM
5268 Bug New Normal Dragging modified version of Sinewave actor to canvas causes gui oddity David Welker 01/05/2011 05:14 PM
5204 Bug Resolved Normal kepler application menus on each kepler window instead of in mac menu bar David Welker 12/01/2010 06:22 PM
5161 Bug Resolved Normal can't always use Module Manager to change to an older patch of a suite David Welker 09/15/2010 11:57 PM
5160 Bug Resolved Normal problem changing suites using Module Manager David Welker 08/25/2010 12:36 PM
3738 Bug Resolved Normal File -> Save As menu item is missing David Welker 01/27/2009 05:50 PM
4858 Bug Resolved Normal Open Actor on non-composite actors no longer works David Welker 03/10/2010 04:17 AM
4784 Bug Resolved Normal Remove or fix and re-enable the fullscreen zoom button debi staggs 02/10/2010 05:34 PM
6614 Bug New Normal parameter editor background color different on Linux Derik Barseghian 08/21/2015 03:44 PM
5890 Bug Resolved Normal kepler crash on mac when clinking 'KeplerData' during saving process. Derik Barseghian 03/14/2013 10:09 AM
5719 Bug Resolved Normal parameter values no longer appear on canvas Derik Barseghian 10/01/2012 06:13 PM
5702 Bug Resolved Normal GUI bug - Initial actor port positioning is wrong Derik Barseghian 09/07/2012 11:08 AM
5692 Bug New Normal Values not committed to actors Derik Barseghian 08/27/2012 06:18 PM
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5638 Bug Resolved Normal "Ok" behavior of Use Module Manager prompt doesn't do what it should when opening from Derik Barseghian 07/13/2012 10:58 AM
Recent Files

5581 Bug New Normal Make Ul improvements to Components Download Derik Barseghian 08/19/2015 10:41 AM
5575 Bug Resolved Normal open composites from outline tab Derik Barseghian 03/14/2012 11:51 AM
5574 Bug Resolved Normal exception from gui in java 7 Derik Barseghian 02/15/2012 08:57 PM
5556 Bug New Normal Add key bind to GUI to avoid connecting edge prematurely Derik Barseghian 11/29/2011 09:43 AM
5545 Bug Resolved Normal Configure Ports dialog Type column gui annoyances Derik Barseghian 06/15/2012 03:54 PM
5540 Bug Resolved Normal Automate Layout no longer uses Kieler on trunk Derik Barseghian 05/01/2012 08:49 PM
5510 Bug New Normal On Ubuntu, Kepler can disappear from the dock while still running Derik Barseghian 08/19/2015 10:47 AM
5277 Bug Resolved Normal remove test servers from Sources preferences Derik Barseghian 01/28/2011 02:00 PM
5231 Bug Resolved Normal Tools => Preferences menu item gives error on trunk Derik Barseghian 10/28/2010 01:15 PM
5191 Bug Resolved Normal GUI improvements to Save As Derik Barseghian 01/05/2011 11:31 PM
5181 Bug Resolved Normal welcome window shows wrong version number Derik Barseghian 09/29/2010 01:13 PM
5180 Bug Resolved Normal Add a new Export File menu option that does a Save As (model xml) Derik Barseghian 09/16/2010 05:29 PM
5165 Bug Resolved Normal implement a GUI Save action for KARs Derik Barseghian 09/28/2010 03:13 PM
5153 Bug New Normal Save As... closes all windows associated with a workflow Derik Barseghian 08/23/2015 02:26 PM
5045 Bug In Progress Normal Add a menu to add and configure new remote kepler servers Derik Barseghian 03/28/2011 05:10 PM
4978 Bug In Progress Normal Create additional 'module’ property for any menu entries that are inserted by non-core modules Derik Barseghian 08/23/2015 02:23 PM
4790 Bug Resolved Normal cmd-click in wrp does not create relation Derik Barseghian 04/13/2010 05:47 PM
4696 Bug Resolved Normal Title bar doesn't refresh after rename during Save Archive Derik Barseghian 02/04/2010 01:59 PM
4438 Bug Resolved Normal View: label shouldn't appear when there's no view drop-down menu Derik Barseghian 01/14/2010 04:37 PM
4434 Bug New Normal Workflow Run Manager - add ability to hide/show columns Derik Barseghian 01/13/2010 02:19 PM
4252 Bug Resolved Normal Workflow Run Manager - deleting a run before running a wf doesn't work Derik Barseghian 07/16/2009 11:12 AM
4251 Bug Resolved Normal Workflow Run Manager - wrong rows when operating on re-sorted table Derik Barseghian 07/31/2009 04:27 PM
4248 Bug Resolved Normal export dialogs should show default extension Derik Barseghian 08/28/2009 12:49 PM
4247 Bug Resolved Normal Application menu items sometimes disappear on OS X Derik Barseghian 06/20/2011 04:00 PM
4171 Bug Resolved Normal dragging actor to canvas then back to component tree area gives NPE Derik Barseghian 12/27/2009 09:23 AM
4144 Bug Resolved Normal Workflow Run Manager - moving columns / new windows bug Derik Barseghian 06/15/2009 11:37 AM
4140 Bug Resolved Normal Workflow Run Manager - delete runs functionality needs to be written Derik Barseghian 08/20/2009 05:11 PM
4135 Bug Resolved Normal Workflow Run Manager - default sorting (by date) should be applied Derik Barseghian 08/07/2009 03:48 PM
4134 Bug Resolved Normal Workflow Run Manager - double clicking on search cell shouldn't sort column Derik Barseghian 08/07/2009 06:24 PM
4133 Bug Resolved Normal Workflow Run Manager - column widths should be size appropriately Derik Barseghian 07/08/2009 06:02 PM
4132 Bug New Normal Workflow Run Manager - Open in New Window is just opening the workflow, not the ROML or Derik Barseghian 11/13/2009 07:23 PM

report

06/24/2024

4/8




# Tracker Status Priority Subject Assignee Updated

4050 Bug Resolved Normal dragging actors can leave artifacts until you stop dragging Derik Barseghian 05/04/2009 03:40 PM
3766 Bug New Normal Improve menu options in text editor Derik Barseghian 04/03/2009 03:18 PM
3706 Bug New Normal Add "Open the container" toolbar button Derik Barseghian 04/03/2009 03:27 PM
3705 Bug New Normal some actor icons don't denote that they are a composite Derik Barseghian 04/03/2009 03:26 PM
3691 Bug Resolved Immediate JButton labels truncated on macOSX Derik Barseghian 05/19/2009 05:57 PM
3542 Bug Resolved Normal Tree View menu is too wide when opened Derik Barseghian 04/03/2009 03:06 PM
3531 Bug New Normal Save As dialog inconsistent between linux and mac Derik Barseghian 04/03/2009 02:45 PM
3440 Bug New Normal add Up and Down buttons to change port order on an actor Derik Barseghian 04/03/2009 02:45 PM
3235 Bug New Normal Add an Edit, Select All menu item and respective accelerator Derik Barseghian 04/03/2009 02:18 PM
3221 Bug New Normal offset new windows Derik Barseghian 04/03/2009 02:18 PM
3172 Bug New Normal windows mouse wheel doesn't scroll canvas Derik Barseghian 02/09/2010 04:19 PM
3130 Bug Resolved Normal Add an accelerator (keyboard shortcut) for opening a new blank workflow Derik Barseghian 04/15/2008 02:51 PM
3094 Bug Resolved Normal File keyboard shortcuts use ctrl key instead of apple key on Mac Derik Barseghian 01/25/2008 12:37 PM
2261 Bug New Normal DIALOGS: Implement New "Advanced Search for Data" Dialog Derik Barseghian 06/09/2009 03:14 PM
1903 Bug Resolved Normal Wrappers to access ADN metadata Efrat Jaeger 10/17/2005 11:09 AM
5349 Bug Resolved Normal Cannot open KAR file after modifying it. jianwu jianwu 06/18/2012 02:55 PM
5348 Bug Resolved Normal Opening KAR or opening workflow under KAR behaves differently. jlanwu jianwu 08/07/2012 04:05 PM
1907 Bug Resolved Normal New ports don't draw when added dynamically Jing Tao 11/02/2005 11:53 AM
1906 Bug Resolved Normal Add reset/cancel button(s) for search in actor panel Jing Tao 11/02/2005 04:21 PM
1893 Bug Resolved Normal Investigate Collapsing Data and Actor Tabs Jing Tao 11/02/2005 11:50 AM
1695 Bug Resolved Normal Multi-node EcoGrid search for Kepler Jing Tao 01/20/2005 10:20 AM
1586 Bug Resolved Immediate Query engine implementation for data query in kepler Jing Tao 01/20/2005 10:24 AM
1585 Bug Resolved Normal Load data into relational db Jing Tao 06/04/2004 09:04 AM
1584 Bug Resolved Immediate Load data into relational db Jing Tao 01/20/2005 10:21 AM
1560 Bug Resolved Normal Afer data searching, click actor panel and both actor panel and data panel will be disappeared Jing Tao 05/18/2004 03:34 PM
1553 Bug Resolved Normal Search Scope for dataset panel Jing Tao 01/20/2005 09:48 AM
2420 Bug Resolved Normal Need a 25x25 kepler icon to decorate title bars Laura Downey 04/21/2006 05:43 PM
2367 Bug New Normal MENUS: Context Menus - Additional context menu designs needed Laura Downey 04/03/2009 02:18 PM
2322 Bug Resolved Normal SVG - Assigning Icons to the Correct Actors in Properties Files Laura Downey 02/17/2006 04:31 PM
2035 Bug Resolved Normal use checkboxes and radio buttons correctly Laura Downey 04/13/2006 03:56 PM
2015 Bug New Immediate Provide more meaningful error messages Laura Downey 04/03/2009 01:48 PM
5490 Bug Resolved Normal update splash screen version without changing image Matt Jones 08/17/2015 09:20 AM
3223 Bug New Normal interactive graphics in R Matthew Brooke 04/03/2009 02:18 PM
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3222 Bug New Normal save new workflow template Matthew Brooke 04/03/2009 02:18 PM
3183 Bug New Normal Return/Enter does not select default button in dialog boxes Matthew Brooke 04/03/2009 02:18 PM
3106 Bug New Normal Out of memory while opening all demos, is -Xss5m or SVG the problem? Matthew Brooke 04/03/2009 02:31 PM
3022 Bug Resolved Normal FSM State cannot be opened from context menu Matthew Brooke 04/02/2008 11:31 AM
2570 Bug New Normal port's context menu should contain renaming Matthew Brooke 04/03/2009 02:04 PM
2569 Bug Resolved Normal Popup (context) menu do not appear for relations and connections Matthew Brooke 04/30/2009 05:05 PM
2561 Bug Resolved Normal context menu of attributes Matthew Brooke 10/06/2006 04:13 PM
2452 Bug New Normal consider providing management console for workflow engineer Matthew Brooke 04/03/2009 02:18 PM
2451 Bug New Normal consider providing data-centric/data management feature in Kepler Matthew Brooke 04/03/2009 02:02 PM
2450 Bug New Normal consider better mechanism for navigating multi-level workflow Matthew Brooke 04/03/2009 02:02 PM
2446 Bug New Normal ICONS: Handle missing thumbnails elegantly Matthew Brooke 04/03/2009 02:00 PM
2445 Bug New Normal DataSource: add code to assign & display new raster thumbnail Icons for search results list Matthew Brooke 04/03/2009 02:00 PM
2440 Bug Resolved Normal Saving Workflow Matthew Brooke 04/12/2007 02:50 PM
2433 Bug Resolved Immediate Change Actor Library folder icons to ontology symbols Matthew Brooke 05/19/2006 10:52 AM
2416 Bug In Progress Normal ICONS: Tracking bug - Rearranging and regenerating icons Matthew Brooke 04/03/2009 02:00 PM
2414 Bug New Normal Opening a preexisting model should open in a blank viewer Matthew Brooke 04/03/2009 02:18 PM
2413 Bug Resolved Normal ICONS: Monitor Value icon should show value Matthew Brooke 04/20/2006 02:36 PM
2410 Bug New Normal need feature in Ul for users to assign icon to an actor Matthew Brooke 04/03/2009 02:18 PM
2397 Bug New Normal TOOLTIPS: dual screen setup - tooltip sometimes shown on wrong screen Matthew Brooke 04/03/2009 02:18 PM
2396 Bug Resolved Normal TOOLTIPS: Sometimes line/relation tooltip appears when hovering over port Matthew Brooke 12/11/2007 09:53 AM
2392 Bug Resolved Normal MENUS: Top-Level Menu - need centralized way to remove menubar Matthew Brooke 04/04/2006 10:17 AM
2383 Bug Resolved Normal mnemonics in menus not appearing Matthew Brooke 03/28/2006 07:40 AM
2374 Bug Resolved Immediate SVG - Improve inital rendering times Matthew Brooke 04/03/2009 01:11 PM
2365 Bug Resolved Normal MENUS: Context Menus - grab right-click for graph links Matthew Brooke 03/01/2006 02:07 PM
2362 Bug In Progress Normal DataSourcelcon: use new SVG Icons dynamically, instead of drawing icon Matthew Brooke 04/03/2009 02:18 PM
2361 Bug Resolved Immediate Using backspace in the search pane deletes highlighted components Matthew Brooke 04/04/2006 04:59 PM
2359 Bug In Progress Normal enable/disable menu items and toolbar items as appropriate Matthew Brooke 04/03/2009 02:18 PM
2358 Bug Resolved Normal need to add "..." to appropriate menu items Matthew Brooke 02/21/2006 09:41 PM
2355 Bug Resolved Normal TOOLBAR: icon states don't display correctly for first four toolbar buttons Matthew Brooke 04/11/2006 02:43 PM
2342 Bug In Progress Normal MENUS: Top-Level Menu - some toolbar buttons showing text Matthew Brooke 04/03/2009 02:18 PM
2341 Bug Resolved Immediate MENUS: Top-Level Menu - Some mapped menu items not working Matthew Brooke 01/26/2006 04:07 PM
2338 Bug In Progress Immediate TRACKING - MENUS: pop-up context menu revision Matthew Brooke 04/03/2009 01:54 PM
2337 Bug In Progress Immediate TRACKING - MENUS: Top-Level Menu Revision Matthew Brooke 04/03/2009 01:54 PM
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2336 Bug Resolved Immediate MENUS: Top-Level Menu - implement class.forName in getActionFor() Matthew Brooke 02/02/2006 12:58 PM
2334 Bug Resolved Immediate MENUS: Top-Level Menu - add support for menu separators Matthew Brooke 01/19/2006 02:26 PM
2333 Bug Resolved Immediate MENUS: Top-Level Menu - relocate code further up class hierarchy Matthew Brooke 03/02/2006 08:35 PM
2332 Bug Resolved Immediate MENUS: Top-Level Menu - link ptii enabled/disabled listeners Matthew Brooke 02/17/2006 06:35 PM
2324 Bug In Progress Normal SVG - old-style icon still displayed for certain actors Matthew Brooke 04/03/2009 01:59 PM
2286 Bug Resolved Immediate SVG - reduce svg file size Matthew Brooke 02/17/2006 06:33 PM
2271 Bug In Progress Normal Changing the Color Scheme Matthew Brooke 04/03/2009 02:18 PM
2270 Bug In Progress Normal TRACKING: Localization and Improvement of User-Visible Messaging Strings Matthew Brooke 04/03/2009 02:18 PM
2269 Bug Resolved Immediate SVG - Small Icon (Actor Library Thumbnail) Matthew Brooke 12/08/2005 02:28 PM
2268 Bug Resolved Immediate SVG - Backward Compatibility Matthew Brooke 12/08/2005 02:27 PM
2267 Bug Resolved Immediate SVG - Memory Usage Matthew Brooke 12/15/2005 09:53 PM
2266 Bug Resolved Immediate SVG - Assigning Icons Matthew Brooke 12/15/2005 09:51 PM
2264 Bug In Progress Normal DIALOGS: Implement New "Semantic Annotation" Dialog Matthew Brooke 04/03/2009 02:18 PM
2263 Bug In Progress Normal DIALOGS: Implement New "Search Ecogrid for Data Sources" Dialog Matthew Brooke 04/03/2009 02:18 PM
2262 Bug In Progress Normal DIALOGS: Implement New "Search Ecogrid for Component Sources" Dialog Matthew Brooke 04/03/2009 02:18 PM
2260 Bug In Progress Normal DIALOGS: Implement New "Advanced Search for Components" Dialog Matthew Brooke 04/03/2009 02:18 PM
2259 Bug In Progress Immediate DIALOGS: Implement New Actor Dialog Matthew Brooke 04/03/2009 01:53 PM
2258 Bug In Progress Immediate DIALOGS: Implement New Director Dialog Matthew Brooke 04/03/2009 01:52 PM
2257 Bug In Progress Immediate DIALOGS: Implement New Workflow Dialog Matthew Brooke 04/03/2009 01:52 PM
2256 Bug Resolved Normal Actor selection problem inside some Composites Matthew Brooke 02/28/2006 08:15 PM
2247 Bug In Progress Normal TRACKING: Popup Dialog Changes Matthew Brooke 04/03/2009 02:18 PM
2245 Bug In Progress Immediate TRACKING: Batik SVG Rendering - remaining tasks Matthew Brooke 04/03/2009 01:31 PM
2235 Bug Resolved Immediate Search text-field only 1 character wide on Mac OS X Matthew Brooke 11/03/2005 08:19 PM
2150 Bug Resolved Normal 'Edit Custom Icon' menu item doesn't work Matthew Brooke 02/28/2006 08:08 PM
2114 Bug Resolved Normal display search results in both heirarchy and flat list Matthew Brooke 02/28/2006 07:00 PM
2109 Bug In Progress Normal make double-click open composite actor Matthew Brooke 04/03/2009 02:18 PM
2108 Bug Resolved Normal changes to simple search Matthew Brooke 11/04/2005 11:14 PM
2107 Bug Resolved Normal add advance search capability for data Matthew Brooke 02/28/2006 08:31 PM
2106 Bug In Progress Normal allow user to save search results Matthew Brooke 04/03/2009 02:18 PM
2056 Bug In Progress Normal Port labels appear 'twice' when DataSource actor added Matthew Brooke 04/03/2009 01:59 PM
2038 Bug Resolved Normal review and correct information design (e.g., graphical layouts) Matthew Brooke 02/28/2006 08:05 PM
2036 Bug In Progress Normal provide different levels of turning displaying annotations Matthew Brooke 04/03/2009 02:18 PM
2034 Bug Resolved Normal provide visual indication of default button/choice on windows/dialogs Matthew Brooke 04/13/2006 03:58 PM
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2030 Bug Resolved Normal deal with terminology issues in Kepler Matthew Brooke 02/28/2006 08:02 PM
2029 Bug In Progress Normal consider guided analysis wizard Matthew Brooke 04/03/2009 02:18 PM
2024 Bug In Progress Normal provide natural language summary of workflow Matthew Brooke 04/03/2009 02:18 PM
2023 Bug Resolved Normal remove redundant labeling in tree Matthew Brooke 10/28/2008 05:49 PM
2016 Bug Resolved Immediate MENUS: pop-up context menu revision Matthew Brooke 01/18/2006 02:48 PM
2013 Bug Resolved Normal Allow case insensitive user input Matthew Brooke 02/28/2006 08:00 PM
2012 Bug In Progress Normal Incorporate combo boxes with pick lists in as many places as possible to minimize user typing and | Matthew Brooke 04/03/2009 02:18 PM

provide knowledge of acceptable choices
2011 Bug In Progress Normal MENUS: Context Menus - Add Cut/Copy/Paste to all right click popup menus Matthew Brooke 04/03/2009 02:18 PM
2008 Bug Resolved Normal Provide real-time feedback for workflow progress as a default Matthew Brooke 11/10/2005 10:18 AM
2005 Bug In Progress Normal associate an visual text annotation with a specific actor Matthew Brooke 04/03/2009 02:18 PM
1911 Bug In Progress Normal Provide real-time feedback/animation for workflow progress as a default Matthew Brooke 04/03/2009 02:18 PM
1884 Bug In Progress Normal Enable drag and drop of ports and relations Matthew Brooke 04/03/2009 02:18 PM
1882 Bug Resolved Normal Investigate Ul Changes Matthew Brooke 11/11/2005 02:30 PM
1845 Bug Resolved Normal user input for port type should not be case sensitive Matthew Brooke 12/20/2005 11:09 AM
1844 Bug Resolved Normal tool tip problems Matthew Brooke 04/06/2006 05:52 PM
1843 Bug Resolved Normal unexpected workflow components tree behavior Matthew Brooke 02/16/2006 12:51 PM
1839 Bug Resolved Immediate adding new port sometimes causes canvas to resize Matthew Brooke 04/12/2007 03:27 PM
1749 Bug In Progress Normal Gilobal toggle for port name display Matthew Brooke 04/03/2009 02:18 PM
1655 Bug In Progress Normal DIALOGS: Implement New Ul for Sources Dialog (was "integrate ecogrid registry into kepler Matthew Brooke 04/03/2009 02:18 PM
ecogrid client")
2343 Bug Resolved Normal add welcome screen for release 1.0 Nandita Mangal 12/13/2007 01:19 PM
4903 Bug Resolved Normal Text in attributes not rendered properly Sean Riddle 11/29/2012 07:30 PM
4877 Bug Resolved Normal The provenance recorder and tagging buttons on the toolbar need tooltips Sean Riddle 03/12/2010 03:20 PM
4304 Bug Resolved Immediate Progress monitor is blank when authenticating for KAR upload Sean Riddle 01/27/2010 11:28 AM
1826 Bug Resolved Immediate keyboard binding to enter key on quick search broken Shawn Bowers 01/06/2005 05:17 PM
4285 Bug New Normal workflow canvas does not repack to fill empty space when top window is resized Timothy McPhillips 01/13/2010 03:57 PM
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